Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip's Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications.

MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademark

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BeaconThings, BitCloud, chipKIT, chipKIT logo, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, Keeloq, Keeloq logo, Kleer, LANcheck, LINK MD, maXstylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB, OptoLyzer, PIC, picPower, PICSTART, PIC32 logo, Propชช Designer, QTouch, RightTouch, SAM-BA, SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight Load, IntelliMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2016-2017, Microchip Technology Incorporated, All Rights Reserved.

ISBN: 978-1-5224-2369-0
Table of Contents

Preface ....................................................................................................................................... 7

Chapter 1. Introduction to the MPLAB® Xpress Evaluation Board
  1.1 MPLAB Xpress Evaluation Board Contents ................................................................. 11
  1.2 MPLAB Xpress Evaluation Board Layout ................................................................. 13
  1.3 Power Sources ............................................................................................................. 15
    1.3.1 USB Connector ....................................................................................................... 15
    1.3.2 2.7V-16V External Power Supply (General Purpose Xpress Board Only) 15

Chapter 2. Getting Started
  2.1 Programming the MPLAB Xpress Evaluation Board .................................................. 17
  2.2 Programming Xpress Board Using MPLAB X ........................................................... 21
  2.3 Navigating Xpress Examples ....................................................................................... 22
  2.4 Using an Existing MPLAB X IDE Project ................................................................. 24

Appendix A. Schematic
  A.1 MPLAB Xpress Evaluation Board Schematic ........................................................... 27

Worldwide Sales and Service ................................................................................................. 33
NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and documentation are constantly evolving to meet customer needs, so some actual dialogs and/or tool descriptions may differ from those in this document. Please refer to our website (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each page, in front of the page number. The numbering convention for the DS number is “DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know when using the Microchip MPLAB® Xpress Evaluation Board User’s Guide. Topics discussed in this chapter include:

• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip WebSite
• Development Systems Customer Change Notification Service
• Customer Support
• Revision History

DOCUMENT LAYOUT

This document describes how to use the MPLAB® Xpress Evaluation Board User’s Guide as a development tool to emulate and debug firmware on a target board. The document is organized as follows:

• Chapter 1. “Introduction to the MPLAB® Xpress Evaluation Board” – This chapter contains general information regarding the Xpress Evaluation Board kit contents, layout and power sources.
• Chapter 2. “Getting Started” – This chapter offers information on how to program the Xpress Evaluation Board, as well as how to import an existing MPLAB X IDE project.
• Appendix A. “Schematic” – This appendix contains the Xpress Evaluation Board schematic.
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

### DOCUMENTATION CONVENTIONS

<table>
<thead>
<tr>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arial font:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Referenced books</td>
<td><em>MPLAB® IDE User’s Guide</em></td>
</tr>
<tr>
<td>Emphasized text</td>
<td></td>
<td><em>...is the only compiler...</em></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A window</td>
<td>the Output window</td>
</tr>
<tr>
<td></td>
<td>A dialog</td>
<td>the Settings dialog</td>
</tr>
<tr>
<td></td>
<td>A menu selection</td>
<td>select Enable Programmer</td>
</tr>
<tr>
<td>Quotes</td>
<td>A field name in a window or dialog</td>
<td>“Save project before build”</td>
</tr>
<tr>
<td>Underlined, italic text with right angle</td>
<td>A menu path</td>
<td><em>File&gt;Save</em></td>
</tr>
<tr>
<td>Bold characters</td>
<td>A dialog button</td>
<td>Click OK</td>
</tr>
<tr>
<td></td>
<td>A tab</td>
<td>Click the <em>Power</em> tab</td>
</tr>
<tr>
<td>N’Rnnnn</td>
<td>A number in verilog format, where N is the</td>
<td>4'b0010, 2'hF1</td>
</tr>
<tr>
<td></td>
<td>total number of digits, R is the radix and n</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is a digit.</td>
<td></td>
</tr>
<tr>
<td>Text in angle brackets &lt; &gt;</td>
<td>A key on the keyboard</td>
<td>Press &lt;Enter&gt;, &lt;F1&gt;</td>
</tr>
<tr>
<td><strong>Courier New font:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plain Courier New</td>
<td>Sample source code</td>
<td><em>#define START</em></td>
</tr>
<tr>
<td></td>
<td>Filenames</td>
<td><em>autoexec.bat</em></td>
</tr>
<tr>
<td></td>
<td>File paths</td>
<td><em>c:\mcc18\h</em></td>
</tr>
<tr>
<td></td>
<td>Keywords</td>
<td><code>_asm, _endasm, static</code></td>
</tr>
<tr>
<td></td>
<td>Command-line options</td>
<td><code>-Opa+, -Opa-</code></td>
</tr>
<tr>
<td></td>
<td>Bit values</td>
<td><code>0, 1</code></td>
</tr>
<tr>
<td></td>
<td>Constants</td>
<td><code>0xFF, ‘A’</code></td>
</tr>
<tr>
<td>Italic Courier New</td>
<td>A variable argument</td>
<td><em>file.o, where file can be any valid filename</em></td>
</tr>
<tr>
<td>Square brackets []</td>
<td>Optional arguments</td>
<td><em>mcc18 [options] file [options]</em></td>
</tr>
<tr>
<td>Curly brackets and pipe</td>
<td>Choice of mutually exclusive arguments; an OR</td>
<td>*errorlevel {0</td>
</tr>
<tr>
<td>character: {}</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ellipses...</td>
<td>Replaces repeated text</td>
<td><em>var_name [, var_name...]</em></td>
</tr>
<tr>
<td></td>
<td>Represents code supplied by user</td>
<td><em>void main (void){ ...}</em></td>
</tr>
</tbody>
</table>
RECOMMENDED READING

This user’s guide describes how to use the Xpress Evaluation Board. For the latest information on using other tools, refer to the MPLAB® X IDE home page: www.microchip.com/mplabx/. This resource page contains updated documentation, downloads and links to other MPLAB X IDE compatible tools, plug-ins and much more.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the website contains the following information:

• **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
• **MPLAB® Xpress Evaluation Board User’s Guide** – Specific product support can be accessed via our website at www.microchip.com/mplab/mplab-xpress
• **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing
• **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip website at www.microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• **Compilers** – The latest information on Microchip C compilers, assemblers, linkers and other language tools. These include all MPLAB C compilers; all MPLAB assemblers (including MPASM™ assembler); all MPLAB linkers (including MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object librarian).
• **Emulators** – The latest information on Microchip in-circuit emulators. This includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.
• **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 debug express.
• **MPLAB X IDE** – The latest information on Microchip MPLAB X IDE, the Windows® Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and MPLAB SIM simulator, as well as general editing and debugging features.
• **Programmers** – The latest information on Microchip programmers. These include production programmers, such as MPLAB REAL ICE in-circuit emulator, MPLAB ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included are non-production development programmers, such as PICSTART® Plus and PICKit 2 and 3.
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the website at:
http://www.microchip.com/support.

REVISION HISTORY

Revision A (April 2016)
Initial release of this document.

Revision B (October 2017)
Updated Chapter 1. Added sections 2.2 and 2.3 in Chapter 2, and figures A-3, A-4, and A-5 in Appendix A. Other minor corrections.
Chapter 1. Introduction to the MPLAB® Xpress Evaluation Board

The MPLAB® Xpress Evaluation Board is a development tool designed to work in conjunction with the cloud-based MPLAB® Xpress Integrated Development Environment (IDE). The combination of the IDE and the Xpress Evaluation Board allows for quick experimentation and code development without having to download the IDE or compilers. There are three variants of Xpress Evaluation Boards:

1. General Purpose MPLAB Xpress Evaluation Board
2. Device Specific MPLAB Xpress Evaluation Board (20-pin variant)
3. Device Specific MPLAB Xpress Evaluation Board (40-pin variant)

The General Purpose Xpress board contains a built-in programmer and includes an 8-bit PIC16F18855 microcontroller, allowing for easy programming without additional programming tools. It also contains a set of four indication LEDs, a potentiometer, a push button switch and a mikroBUS™ socket to accommodate a variety of plug-in MikroElektronika click boards that can be used in application development.

The Device Specific Xpress boards contain a specific PIC16 or PIC18 device the board is targeted towards in addition to the built-in programmer. They are available in 20-pin and 40-pin variants based on the device.

All the Xpress boards contain two sections: the programmer section and the application section. The programmer section contains the circuitry necessary for programming, while the application section contains the circuitry that is used by the microcontroller application.

1.1 MPLAB Xpress EVALUATION BOARD CONTENTS

The Xpress Evaluation Board kit contains the following:

• An Xpress Evaluation Board
• Quick Start Guide
FIGURE 1-1: MPLAB® Xpress EVALUATION BOARD VARIANTS

General Purpose Xpress Board

Device Specific Xpress Board (20-pin variant)

Device Specific Xpress Board (40-pin variant)
1.2 MPLAB Xpress EVALUATION BOARD LAYOUT

Figure 1-2 and Figure 1-3 identify the major features of the MPLAB Xpress Evaluation Boards.

FIGURE 1-2: GENERAL PURPOSE MPLAB® Xpress EVALUATION BOARD LAYOUT

1. PIC® MCU Input/Output Connections
2. PIC16F18855 Microcontroller
3. mikroBUS™ Click Board Socket
4. LEDs
5. Potentiometer
6. Push Button
7. Master Clear Reset Button
8. Battery Connection
9. Micro USB Connector
10. Status LED (Green = Running, Red = Programming)
FIGURE 1-3: DEVICE SPECIFIC MPLAB® XPRESS EVALUATION BOARD LAYOUT

40-pin variant

1. Micro USB Connector
2. PIC® MCU Input/Output Connections
3. PIC16 or PIC18 Microcontroller
4. Master Clear Reset Button
5. Status LED (Green = Running, Red = Programming)

20-pin variant
1.3 POWER SOURCES

The MPLAB Xpress Evaluation Boards can be powered in one of two ways, depending on its usage. It should be noted that only one power source should be connected at a time.

1.3.1 USB Connector

The USB connector will power the entire Xpress Evaluation Board. With USB power connected to J2, Status LED will always be green to indicate that +3.3V is available on the board.

1.3.2 2.7V-16V External Power Supply (General Purpose Xpress Board Only)

The external power supply (Figure 1-2) option is available on the General Purpose Xpress Board only. It will also power the entire Xpress Evaluation Board. The external power supply is connected to a Low Dropout (LDO) voltage regulator, configured to deliver 3.3V to the Xpress board. The external power supply range is from 2.7V to 16V, allowing use with two to six primary cells, 9V alkaline batteries, or one or two-cell Li-Ion batteries. LED D1 will illuminate green when the external power supply is active and supplying sufficient voltage.
Chapter 2. Getting Started

The Xpress Evaluation Boards are designed to work with the MPLAB® Xpress IDE, but can also be used with MPLAB® X IDE. MPLAB Xpress IDE does not require any downloads and can be accessed by visiting mplabxpress.microchip.com.

The Xpress Evaluation Boards allow for rapid development of custom applications without the need to download the IDE or compilers to a computer and allows the storage of a project in the cloud. This allows a user the ability to access their project from virtually anywhere (requires Internet connection) and from any computer. Microchip also provides code examples to help get you started.

2.1 PROGRAMMING THE MPLAB Xpress EVALUATION BOARD

Programming the Xpress board is accomplished by connecting a micro USB cable to the on-board USB connector, creating the .hex file, and dragging and dropping the .hex file into the Xpress board.

To begin, connect a micro USB cable to the on-board USB connector. Next, open the MPLAB Xpress IDE.

The procedure to create a new project or open an existing MPLAB Xpress project is the same as within MPLAB X IDE. Navigate to the File tab, select Project Properties > Configuration > Hardware Tool > Hardware Tools and select 'Simulator/Xpress Board' (see Figure 2-1). This ensures that the Xpress board is chosen as the development tool. Once selected, the ‘Simulator/Xpress Board’ selection will appear under the ‘Debug Tool’ section in the Dashboard window (see Figure 2-2). Once the project is open and ready to program into the target device, simply click on the Make and Program Device button (see Figure 2-3). MPLAB Xpress will build and compile the project, and once completed, will open or save the .hex file that was created. Under the Save button, you can either hit Save and the .hex file will be stored in your downloads folder, or you can hit Save as and choose the location for the .hex file. It is important to remember where the file is stored since the .hex file is what will be programmed into the target PIC® device.
FIGURE 2-1: SELECTING THE Xpress EVALUATION BOARD IN THE MPLAB® X IDE
FIGURE 2-2: SELECTING THE XPRESS EVALUATION BOARD IN THE MPLAB® XPRESS IDE (CONT)
FIGURE 2-3: MAKE AND PROGRAM DEVICE
The Xpress Evaluation Board will show as a mass storage device on the computer (see Figure 2-4). To program the device, simply drag and drop the \texttt{.hex} file image into the Xpress drive. The process is the same for Windows, Linux or OS X.

\textbf{FIGURE 2-4: MPLAB® Xpress BOARD AS MASS STORAGE}

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{figure2_4}
\end{figure}

\section{2.2 PROGRAMMING XPRESS BOARD USING MPLAB® X}

Xpress Boards can be programmed using MPLAB X by following the same steps as described in Section 2.1 “Programming the MPLAB Xpress Evaluation Board” for MPLAB Xpress. In addition to drag-and-drop, MPLAB X can run a post-build script to perform this action automatically. To set this up, right click on \textit{Project Name > Properties > Building} and check the \textit{Execute this line after build}. In the text box below it, type:

\begin{verbatim}
cp ${ImagePath} <Path to XPRESS>
\end{verbatim}

Replace <Path to XPRESS> with the actual location where XPRESS board is mounted. For example, on Windows, if the XPRESS board is mounted at D:\, the script would look like:

\begin{verbatim}
cp ${ImagePath} D:\
\end{verbatim}

For Mac OS X, if the XPRESS board is mounted at /Volumes/XPRESS, the script would look like:

\begin{verbatim}
cp ${ImagePath} /Volumes/XPRESS
\end{verbatim}
For Linux, if the XPRESS board is mounted at /media/XPRESS, the script would look like:

```bash
cp ${ImagePath} /media/XPRESS
```

**FIGURE 2-5: PROGRAMMING SETTINGS ON MPLAB® X**

Click on **Apply** and **OK**. Next time when the **Make and Program Device** button is clicked, the `.hex` file will be copied over to the Xpress board automatically.

### 2.3 NAVIGATING XPRESS EXAMPLES

MPLAB Xpress comes with many examples that demonstrate how to use different peripherals for different devices. In order to navigate to the examples, on the top menu bar, click on the "Examples" link.

**FIGURE 2-6: NAVIGATING TO XPRESS CODE EXAMPLES**
The next window that opens up contains many MPLAB Xpress Code Examples. Filter the results based on Author, Board and Device. The code examples with the Microchip logo for author have been functionally tested and verified by Microchip Technology for that board and device. Click on the name of the example to read the description of the example. Click the red "IDE" button across the desired example to open them up in MPLAB Xpress IDE.

FIGURE 2-7: FILTERING AND OPENING CODE EXAMPLES
2.4 USING AN EXISTING MPLAB® X IDE PROJECT

To load an existing MPLAB X IDE project into MPLAB Xpress, the MPLAB X IDE project must be packaged so that it can be imported by MPLAB Xpress. In MPLAB X IDE, right click on the project that is to be imported into MPLAB Xpress and select Package. MPLAB X IDE will create a ZIP file that will be imported by MPLAB Xpress. Open MPLAB Xpress and under the File tab, select Import Project (see Figure 2-8).

FIGURE 2-8: IMPORT EXISTING MPLAB® X IDE PROJECT
The Import Project window will appear (see Figure 2-9). The window also explains how to prepare your MPLAB X IDE project to import. Click Next.

**FIGURE 2-9: IMPORT PROJECT WINDOW**
The Import Project window will now ask for a project name and allow you to browse for your MPLAB X IDE project (see Figure 2-10). Add a name to your project and then navigate to the folder in which your ZIP file was stored. Select the ZIP file and click Finish. MPLAB Xpress will then open your ZIP file and load the necessary files.

FIGURE 2-10: NAMING AND SELECTING MPLAB® X IDE PROJECT TO IMPORT
Appendix A. Schematic

A.1 MPLAB® Xpress EVALUATION BOARD SCHEMATIC

FIGURE A-1: MPLAB® Xpress GENERAL PURPOSE EVALUATION BOARD SCHEMATIC
(APPLICATION SECTION)
FIGURE A-2: MPLAB® Xpress GENERAL PURPOSE EVALUATION BOARD SCHEMATIC (PROGRAMMER SECTION)
FIGURE A-3: MPLAB® Xpress 20-PIN DEVICE SPECIFIC EVALUATION BOARD SCHEMATIC
FIGURE A-5: MPLAB® Xpress 40-PIN DEVICE SPECIFIC EVALUATION BOARD SCHEMATIC